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1. Quick Start Guide

The Serial Lite III Streaming IP core provides the capability of generating design
examples for selected configurations.

Figure 1. Development Stages for the Design Example

Related Information

Intel Arria 10 SeriallLite III Streaming IP Core Design Example User Guide Document
Archives on page 35

Provides a list of user guides for previous versions of the Serial Lite III Streaming
IP Core Design Example.

1.1. Directory Structure

The Intel® Quartus® Prime software generates the design example files in the
following folders:

e <user_defined design exanple directory>/ed sim
e <user_defined _design_exanpl e directory>/ed synth
e <user_defined _design_exanpl e _directory>/ed hw est

The following diagrams show the directories that contain the generated files for the
design examples.
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Directory Structure for Intel Arria® 10 Serial Lite III Streaming Design

Eﬁ ed_sim

ﬁ aldec

‘D cadence

‘D mentor

‘D seriallite_iii_streaming
‘D synopsys

‘B th_components

Table 1.

ed_hwtest

(4 software

Directory and File Description for Design Example Folder

Directory/File

Description

ed_sinmtb_conponents

The folder that contains the testbench files.

ed_si m cadence

ed_si mf ment or

ed_sinf al dec

ed_si m synopsys/ vcs or ed_si ml synopsys/ vcsnx

The folder that contains the simulation script. It also serves
as a working area for the simulator.

ed_sinmseriallite_iii_streamng The folder that contains the design example simulation
source files.

ed_synth/seriallite_iii_stream ng_deno. qpf Quartus project file.

ed_synth/seriallite_iii_stream ng_deno. gsf Quartus settings file.

ed_synth/seriallite_iii_streanm ng_deno. sdc Synopsys Design Constraints (SDC) file.

ed_synth/src

The folder that contains the design example synthesizable
components.

ed_synth/src/seriallite_iii_stream ng_deno.v Design example top-level HDL.
ed_synth/src/seriallite_iii_stream ng/synth/ Design example DUT top-level files.
seriallite_iii_streamng.v

ed_synth/src/ deno_control

The folder for each synthesizable component including
Platform Designer generated IPs, such as demo_mgmt and
demo_control

ed_hwt est

The folder that contains the design example hardware setup
files.

ed_hwt est / Readne. t xt

Instruction file to download the generated design example
on the development kit.

ed_hwt est/ bui |l d_deno_control . sh

A script to generate demo control and PLL IPs with NIOS II
processor.

continued...
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Directory/File Description
ed_hwt est/ nast er _export.v User interface Verilog design file.
ed_hwt est/ mast er _export _hw. tcl Component description file for master export custom IP.
ed_hwt est/software The folder that contains scripts to download the
demo_control program into NIOS II processor and open an
interactive terminal to run the design example.

1.2. Designh Example Components

Figure 3. Design Example Block Diagram

ATXPLL
(Only for Intel Arria 10 Devices)

o] i w
| Serial Lite IIl Streaming IP Core |
| |
: Serial Lite Il | Serial LitiIIIkSTtreaming
Traffic L Streaming : Ink Tk >
Generator | Duplex |
Demo ! !
Management : : Serial Lite Il Streaming
Traffic | ) Link Rx
Checker t |
| |
| |
T J
Demo Management
Interface
Demo Control JTAG
Platform Designer Subsystem interface

1.3. Generating the Design

You can use the Serial Lite III Streaming IP core parameter editor in the Intel Quartus
Prime software to generate the design example.

Figure 4. Procedure

StartPa.rameter > SpecifyIPVariat.ion > ) Select > Specify - > . Initiate .
Editor and Select Device Design Parameters Example Design Design Generation
D Send Feedback Serial Lite III Streaming Intel Arria 10 FPGA IP Design Example User Guide
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Figure 5. Example Design Tab

1.3.1. Proced
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% parameters i - ot 0| petats 5 [EE ok Symbol | &8 -
‘System: unnamed _Path: serfalte_ii_a10_0 ]
System: unnamed allte NI.210.0 — — - g | @ show signais

. . 4 Detalls

Arria 10 SerialLite Ill Streaming A

seriallte_iil_al0 Generate Example Design. - Initiates Design
core_reset ser_clock |- Generation
| Bxample Design |

[~ Available Example Designs. 1 phy_mgmt_clid ser_clock |

ghy_mgmt_cle user]
Select Design: [standard_clocking_Mode_2x10G [+
= phy_mgmt_clk_reset ser_clock [
= Files Types Generated ] gh_momt_clk_reset
Generate Files for phy_mgrm] ser_clock |
mgmt_address[11.0] user]
I Synthesis i e
frror_tx
@l simulation EEEN10)
it —
The example design supRorts generation, simulation, and Quartus compilation flows for any Selected device. To use the mgmt_writedata(31.0] ink_up_tx
example design for simulation, select the ‘Simulation’ aption above. To use the example desian for compilation and mgmi_vattrequest
harcware, select the Syrthesis' option above
x_serial_clK Hata _rx
 Generated WDL Format 1] pserial ci1.0)
Generate File Format Veriog | v ‘ >

[+ Target Development Kit ]| | [ 1a" presers 5 -

Select Board: [No Development kit - Presets for serialite_ii.a10.0

Example Design generation wil produce necessary files for Quartus compile. The Quartus x

Setings File (QSF) will have pin assignments set 1o virtual pins,

The fleld Device Selected under the Target Device category below displays the target

device for this Example Design. if you need to change the target device, follow Instructions

providect I the field To Change Target Device under Target Device below. Preset Library

* Target Device

Device Selected:  Family: Arria 10 Device: 10AS016C3U19E2LG

To change Target Device: From the menu bar use View -> 'Device Family’ to select
desired device. When completed the Device Selected field above reflects the new device

ure

This is a general procedure on how to generate the design example.

To generate the design example from the IP parameter editor:

1.

4.

In the IP Catalog (Tool s > | P Cat al 0g), locate and select Serial Lite III

Streaming. The IP parameter editor appears.

Specify a top-level name and the folder for your custom IP variation, and the

target device. Click OK.

Select a design from the Presets library. When you select a design, the system

automatically populates the IP parameters for the design.

Note: If you select another design, the settings of the IP parameters change
accordingly. Only designs generated from the presets support hardware

design examples.
Specify the parameters for your design.

5. Click the Generate Example Design button.

The software generates all design files in the sub-directories. These files are required
to run simulation, compilation, and hardware testing.

1.3.2. Design

Example Parameters

The Serial Lite III Streaming IP parameter editor includes an Example Design tab for
you to specify certain parameters before generating the design example.

Table 2. Parameters in the Example Desigh Tab

Parameter

Description

Select Design

design.

Available example designs for the IP parameter settings. When you
select a design from the Preset library, this field shows the selected

Generate Files for

The files to generate for different development phases.

continued...
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Parameter Description

Simulation—when selected, the necessary files for simulating the design
example are generated.

Synthesis—when selected, the synthesis files are generated. Use these
files to compile the design in the Quartus Prime software for hardware
testing.

Generate File Format The format of the RTL files for simulation—Verilog or VHDL.

Select Board

Supported hardware for design implementation. When you select an
Intel development board, the Target Device is the one that matches the
device on the Development Kit.

If this menu is grayed out, there is no supported board for the options
that you select.

Intel Arria® 10 GX Transceiver Signal Integrity Development Kit:
This option allows you to test the design example on selected Intel
development kit. This selection automatically selects the Target Device
to match the device on the Intel development kit. If your board revision
has a different device grade, you can change the target device.

Custom Development Kit: This option allows you to test the design
example on a third party development kit with Intel device, a custom
designed board with Intel device, or a standard Intel development kit
not available for selection. You can also select a custom device for the
custom development kit.

No Development Kit: This option excludes the hardware aspects for
the design example.

Change Target Device Select a different device grade for Intel development kit. For device-

specific details, refer to the device datasheet on the Intel FPGA website.

1.3.3. Presets

Note:

Standard presets allow instant entry of pre-selected parameter values in the IP and
Example Design tabs. You can select the presets at the lower right window in the
parameter editor.

The parameter values chosen for the presets belong to the group of supported Serial
Lite III Streaming IP configurations for design example generation. You can select one
of the presets available for your target device to quickly generate a design example
without having to manually set each parameter in the IP tab and verifying that the
parameter matches the supported configurations set.

Only designs generated from the presets support hardware design examples.
There are four preset settings available in the library that support Duplex, Sink and
Source modes:

e Advanced Clocking Mode 2x10G

e Advanced Clocking Mode 6x12.5G

e Standard Clocking Mode 2x10G
e Standard Clocking Mode 6x12.5G

D Send Feedback Serial Lite III Streaming Intel Arria 10 FPGA IP Design Example User Guide
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Table 3. Parameter Settings for Intel Arria 10 Design Example Presets
Presets Advanced Clocking Advanced Clocking Standard Clocking Standard Clocking
Mode 2x10G Mode 6x12.5G Mode 2x10G Mode 6x12.5G
Direction Duplex, Sink, and Duplex, Sink, and Duplex, Sink, and Duplex, Sink, and
Source Source Source Source
Number of lanes | 2 6 2 6
Meta frame 200 8191 200 8191
length in words
Transceiver 644.53125 312.5 644.531187 312.5
reference clock
frequency (MHz)
Enable M20K ON and OFF ON and OFF ON and OFF ON and OFF

ECC support

Clocking Mode

Advanced clocking

Advanced clocking

Standard clocking

Standard clocking

rate (Gbps)

mode mode mode mode
Required user 150.8395522 186.4760558 146.484375 177.556818
clock frequency
(MHz)
Transceiver data | 10.3125 12.5 10.312499 12.5

1.4. Simulating the Design

These general steps describe how to compile and run the design example simulation.
For specific commands for each design example variant, refer to its respective section.

1.4.1. Procedure

o Run Analyze
Testbench —» . ) . y
. <Simulation Script> Results
Directory
To compile and simulate the design:
Change to
Testbench —» . Ryn . —» Analyze
) <Simulation Script> Results
Directory

1. Change the working directory to <example_design_directory>example/ed_sim/
<simulator>.

2. Run the simulation script for the simulator of your choice.

Simulator

Command

ModelSim*

do run_th.tcl

VCS®/VCS MX

sh run_tb.sh

Aldec™

do run_th.tcl

NC-Sim

sh run_tb.sh

Serial Lite III Streaming Intel Arria 10 FPGA IP Design Example User Guide
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A successful simulation ends with the following message, "Test Passed."

After successful completion, you can analyze the results.

1.5. Compiling and Testing the Design

The Serial Lite III Streaming IP Core parameter editor allows you to compile and run
the design example on a target development kit.

Compile Design
in Quartus Prime | SetupHardware

Software

Test Design
in Hardware

v

Program Device »

Follow these steps to compile and test the design in hardware:

1. Launch the Intel Quartus Prime software and change the directory to /ed_synth/
and open the seriallite_liii_streaming_demo.qpf file.

2. Click Processing> Start Compilation to compile the design.

The timing constraints for the design example and the design components are
automatically loaded during compilation.

Connect the development board to the host computer.

Configure the FPGA on the development board using the generated .sof file
(Tools> Programmer).

The Intel Quartus Prime version 15.1 only supports programming file generation
for Arria 10 engineering sample devices. For more information on support for Arria
10 production devices, contact your local Intel representative or use the support
link from Intel website.

The design examples target the Intel Arria 10 Transceiver Signal Integrity
Development Kit.

The design includes an SDC script as well as a QSF with verified constraints in
loopback mode. If you use the design example with another device or development
board, you may need to update the device setting and constraints in the QSF file.

You must use correct pin constraints when using the core in simplex mode or when
using more than one reconfiguration controller. The synthesized design typically
includes a reconfiguration interface for at least three channels because three channels
share an Avalon® Memory Mapped (Avalon- MM) slave interface, which connects to
the Transceiver Reconfiguration Controller IP core. Conversely, you cannot connect
three channels that share an Avalon-MM interface to different Transceiver
Reconfiguration Controller IP cores or you will receive a Fitter error.

D Send Feedback Serial Lite III Streaming Intel Arria 10 FPGA IP Design Example User Guide
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2. Detailed Description for Intel Arria 10 Serial Lite III
Streaming Standard Clocking Mode

These design examples demonstrate the functionalities of data streaming using
standard clocking mode.

To generate the design examples, select the following preset(s):

e Standard Clocking Mode 2x10G

e Standard Clocking Mode 6x12.5G

By default, the design examples are generated as duplex core. To generate the design
examples in simplex core, select Simplex for the Direction parameter.

Related Information

e Testbench on page 17

e Serial Lite III Errata

2.1. Features

Features for Standard Clocking Mode 2x10G design example includes:
e Support 2 lanes with 10Gpbs transceiver data rate

e Support simplex and duplex transmission modes

o Traffic checker for data verification and lane de-skew verification
e Support CRC error injection using Nios II processor

Features for Standard Clocking Mode 6x12.5G design example includes:
e Support 6 lanes with 12.5Gpbs transceiver data rate

e Support simplex and duplex transmission modes

e Traffic checker for data verification and lane de-skew verification

e Support CRC error injection using Nios II processor

2.2. Hardware and Software Requirements
Intel uses the following hardware and software to test the example designs in a Linux
system:
e Intel Quartus Prime software

e ModelSim - Intel FPGA Edition, Modelsim-SE, NC-Sim (Verilog only), or VCS
simulator

e Intel Arria 10 GX Transceiver Signal Integrity Development Kit for hardware
testing

Intel Corporation. All rights reserved. Agilex, Altera, Arria, Cyclone, Enpirion, Intel, the Intel logo, MAX, Nios,

Quartus and Stratix words and logos are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or

other countries. Intel warrants performance of its FPGA and semiconductor products to current specifications in Iso
accordance with Intel's standard warranty, but reserves the right to make changes to any products and services 900}:2015
at any time without notice. Intel assumes no responsibility or liability arising out of the application or use of any Registered
information, product, or service described herein except as expressly agreed to in writing by Intel. Intel

customers are advised to obtain the latest version of device specifications before relying on any published

information and before placing orders for products or services.

*QOther names and brands may be claimed as the property of others.
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2.3. Functional Description

The desigh examples consist of various components. The following block diagrams
show the design components and the top level connections of the design examples.

Figure 6. Design Example for Simplex Core in Standard Clocking Mode
Transceiver Reset PLL Power
Controller Down
Simplex Standard
. 7CI70cEirLg !ariatlorl 1tx,serial,(lk ATXPLL pll_ref_clk
| j
! src_link_u
snk_core_reset_n ! : . ;aivﬁw ; n >
sv: ore_reset_n ! Serial Lite lll T = iy,
C_core_reset_| Traffic " ing | 1 phy_mgmt_clk Serial Lite lll Streaming
Generator 7| source | LinkTx
| ! xavr_pll_ref_dk
|
Demo !
Management | L xovr_pl_ref_dk SeralLite Il Streaming
PN Link Rx
Traffic ; Serial Lite Il [ 1 PRY Clock
Checker i Streaming (€ : phy_mamt_k —
Ly Sink ‘ rx_activitiy_n >
! t AT
demo_mgmt_clk [ 4 sni-nk-up
Demo Management
Interface
<«
e M G —— o

' ' '

Avalon Interconnect ‘

| ! t

Demo Control Platform Designer Subsystem
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Figure 7. Design Example for Duplex Core in Standard Clocking Mode

Transceiver Reset PLL Power
Controller Down

Duplex Standard

Clocking Variation tx_serial_ck ATXPLL pll_ref_ck
. _-ocking Yarlation B
sc_link_up

t_activitiy_n

.
| I
| I
| T
— ,
I
sLoeresetn | Traffic ' Serial Lite Il ! Serial Lite ll Streaming
e
Generator SFIE ! LinkTx
I
I
I
I
[l
I
I
,
L

snk_core_reset_n

I_ref_clk
Duplex yvr_pll_ret_d SerialLite Il Streaming
Link Rx

Demo

|
|
Management |
Traffic
[ " Checker I
|

PHY Management Clock

hy it_dk
pry-mgmt( nadtiity_n
i ,
demo_mamt_ck tp- - - B st link_up
Demo Management
Interface
f—]
Avalon Master Avalon Master JTAG w
Export Bxport UART Reset Controller
‘ Avalon Interconnect ‘
Interval Nios 1l
RAM
Timer U

Demo Control Platform Designer Subsystem

2.3.1. Design Example Components

The design example consists of following components:
e Serial Lite III Streaming IP core variation

e ATXPLL

e Traffic generator

e Traffic checker

e Demo control

e Demo management

e Nios® II processor code

2.3.1.1. Serial Lite III Streaming IP Core

The Serial Lite III Streaming IP core in this variant can either accepts data from the
traffic generator and format it for transmission or receive data from the link, strips the
headers, and presents it to the traffic checker for analysis. The core is generated with
the parameter settings you select using the parameter editor in the Intel Quartus
Prime software.

2.3.1.2. ATX PLL

The ATX PLL generates transmit transceiver clock to the Serial Lite III Streaming IP
core.
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Related Information

How to compensate the jitter of PLL cascading or non-dedicated clock path for Intel
Arria 10 reference clock?
In previous Quartus Prime versions, reference clock from a cascaded PLL output,
global clock, or core clock causes additional jitter in Intel Arria 10 Serial Lite III
Streaming IP core design example. If you are migrating your design from earlier
versions to Quartus Prime 17.1, refer to the KDB link.

2.3.1.3. Traffic Generator

Figure 8.

Table 4.

The traffic generator generates traffic in a deterministic format to verify that data is
transmitted correctly across the link. Traffic consists of sets of sample words, one for
each lane on the link, that are presented to the source user interface.

Traffic Generator Sample Word Format
This figure shows the format of the sample words generated for each lane.
3B 8101818 312 BI312131518151a 2165 2 813 512 13 7 3 1212 313 313 3 31713 21235 1316l 8 716 o2 3121715 ol8] e[l 2]
Byte7 Byte 6 Byte 5 Byte 4 Byte3 Byte 2 Byte 1 Byte 0
7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0 7‘6‘5‘4‘3‘2‘1‘0
Word ID Burst Count ‘ Word Count ‘

Traffic Generator Sample Word Fields

Field

Bits Description

Word ID

63-59 Contains a static value to distinguish which 64-bit word on the user interface that this
sample was presented on. The Word ID value ranges from 0 to (lanes - 1).

Burst Count

58-32 Tracks the number of bursts used to transfer the sample data. This field value starts with
one after reset and is incremented each time the st art _of _bur st signal is asserted on
the source user interface.

Word Count

31-0 Tracks the number of valid sample words that have been transferred, across all bursts, to
the source user interface.

2.3.1.4. Traffic Checker

The traffic checker performs the following inspections to verify that the received data

conforms to the expected format:
e Checks each sample word to verify that the expected word ID was received.

e Checks each sample word to verify that the word count value is higher than the
word count value from the last valid sample word.

e \Verifies that lane de-skew has been properly performed by validating that the
word count and burst count values from the sample word are the same as the
values received from the adjacent lane.

e Ifthestart_of burst signal is asserted on the user interface, verifies that the
burst count value in the current sample word is higher than the burst count value
from the last valid sample word. Otherwise, it verifies that the burst count value
has not changed.

2.3.1.5. Demo Control

The demo control module is a Nios II processor system, generated in Platform

Designer (Standard), to control the demo hardware.
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Demo control module also consists of a timer to track interrupt occurrence, Avalon-MM
interface to access demo management and the Serial Lite III Streaming Intel FPGA IP
PHY interface, a reset controller, a UART interface, and an Avalon Streaming (Avalon-
ST) interface.

2.3.1.6. Demo Management

The demo management module controls the user modules interaction with the Serial
Lite III Streaming IP core such as enable and disable traffic generator and traffic
checker, enable CRC error insertion, and provide user clock reset for Serial Lite III
Streaming IP core. The module also implements CSRs to control and monitor the
design operation. This includes CSRs to monitor and log errors that occur during the
operation.

2.3.1.7. Nios II Processor Code

The Nios II processor controls the options exercised in the design example. The code
also enables CRAM bits for CRC-32 error injection support. The error injection support
in 10G PCS is based on groups of three channels or triplets. Setting the corresponding
bit for a given channel in the triplet enables CRC error injection for all of the lanes that
use any channel in the given triplet.

The design example sets the bit for channel 0 that connects to lane 0 in the design
example. Therefore, CRC error injection is exercisable for lane 0 only. Refer to the
Nios II processor source code (demo_control.c) for information on setting bits for
other channels.

2.3.2. Reset Scheme

The ngnt _r eset _n reset signal controls the overall reset structure for the design
example. This is an asynchronous and active-low signal. Asserting this signal resets
the demo control module and the Serial Lite III Streaming IP core. The traffic
generator and traffic checker modules get reset through the demo management and
the Serial Lite III Streaming IP core.

The following diagrams show the reset scheme implemented in the design examples.
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Figure 9.

Standard Clocking Mode
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2.3.3. Clocking Scheme

The following diagrams show the clocking scheme for the design examples.
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Clocking Scheme for Intel Arria 10 Serial Lite III Streaming Simplex Core in
Standard Clocking Mode

Figure 11.
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Figure 12. Clocking Scheme for Intel Arria 10 Serial Lite III Streaming Duplex Core in
Standard Clocking Mode
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2.4. Simulation

mgmt_dk

The simulation test cases demonstrate continuous streaming of 2000 sample data for
all lanes from traffic generator to the Serial Lite III Streaming source core and
externally loopback to the sink core in standard clocking mode.

The simulation test case performs the following steps:

1.

i hwN

Initialize and configures Serial Lite III Streaming IP core, traffic generator and

traffic checker.

Traffic generator generates data and starts data transmission.

Logs and display link up status and burst information.

Traffic checker verifies received data and stop transmission.

Testbench logs and displays test result and test information.

2.4.1. Testbench

If your design targets Intel Arria 10 devices, the generated example testbench is
dynamic and has the same configuration as the IP.

When you choose the sink or duplex direction, the parameter editor generates an
external transceiver ATX PLL for use in the Intel Arria 10 testbench.
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Figure 13. Serial Lite III Streaming Example Testbench (Duplex) for Intel Arria 10
Devices

Test Environment

Device Under Test (Duplex Mode)
»

Traffic »  Source Source < Transceiver
< Generator Application Adaptation < TXPLL
.l al

Source Loopback
) e A
Generator
Testbench Duplex-
< . ) ) Interlaken
Traffic Sink Sink Sink
Check Adaptation || Application || Al it Skew
: ecker aptation pp! ignment < Insertion
Sink
P Clock
Generator

Figure 14. Serial Lite III Streaming Example Testbench (Simplex) for Intel Arria 10
Devices
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2.5. Hardware Testing

Once you download the design and accompanying software into the FPGA, you can
test the design operation through the interactive session. The interactive session

provides helpful statistics, as well as controls for controlling various aspects of the
design.
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You can control the following operations through the interactive session by entering
the option numbers listed below:

e 1) Enable Data Generator/Checker - Enables the traffic generator and start
sending out data.

e 2) Disable Data Generator/Checker - Disables traffic generation.
¢ 3) Reset Source Core - Resets the source core and traffic generator.
e 4) Reset Sink Core - Resets the sink core and traffic checker.

e 5) Display Error Details - Displays the error statistics.

e 6) Toggle Burst/Continuous Mode - Resets the source and sink MACs and
switches the traffic generator to generate a burst or continuous traffic stream. By
default, the design example is set to burst mode. When in continuous mode, the
burst count will always show 1. Disable the data generator/checker before
switching mode to avoid transmission error.

e 7) Toggle CRC Error Insertion - Turns CRC error injection off or on. By default,
the design example has CRC error injection turned off.

2.5.1. Design Setup

The design example targets the Intel Arria 10 Transceiver Signal Integrity
Development Kit.

The design includes an SDC script as well as a QSF with verified constraints in
loopback mode. If you use the design example with another device or development
board, you may need to update the device setting and constraints in the QSF file.

You must use correct pin constraints when using the core in simplex mode or when
using more than one reconfiguration controller. The synthesized design typically
includes a reconfiguration interface for at least three channels because three channels
share an Avalon-MM slave interface, which connects to the Transceiver Reconfiguration
Controller IP core. Conversely, you cannot connect three channels that share an
Avalon-MM interface to different Transceiver Reconfiguration Controller IP cores or you
will receive a Fitter error.

Related Information

Altera Transceiver PHY IP Core User Guide
More information about the Interlaken PHY IP core.

2.5.2. Error Details

These are the list of supported errors in the design example.

Table 5. List of Error Details
Error | Description

Source Error:

Adaptation FIFO Overflow | To indicate source adaptation FIFO overflow error.

Sink Errors:

Adaptation FIFO Overflow To indicate sink adaptation FIFO overflow error.

Loss of Alignment During Normal Operation To indicate loss of alignment error (error _rx[ 1]).

continued...
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Error Description
Meta Frame CRC Errors To indicate CRC errors.
Lane Swap Errors To indicate lane swap errors in traffic checker.
Lane Sequence Errors To indicate lane sequence error in traffic checker.
Lane Alignment Errors To indicate lane alignment error in traffic checker.

2.6. Signals

Figure 15. Top-level Signals for Intel Arria 10 Serial Lite III Streaming Standard
Clocking Mode Design Example

Serial Lite Il Streaming Intel Arria 10
Standard Clock Design Example
mgmt_clk snk_core_reset_n
—>
mgmt_reset_n src_core_reset_n
— > —>
pll_ref_clk sink_link_up_n
> —>
rx [n] src_link_up_n
_> —>
rx_activity_n
tx_activity_n
tx [n]
Table 6. Design Example Interface Signals
Signal Direction Width Description
Clock and Reset Signal
nmgmt _cl k Input 1 Input clock for:

e Avalon-MM PHY management
interface for Serial Lite III Streaming
IP core

e Demo management module
e Demo control module
e Transceiver reset controller

continued...
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Signal Direction Width Description

pll_ref_clk Input 1 This reference clock is used by the Clock
Data Recovery (CDR) unit in the
transceiver. It serves as a reference for
the CDR to recover the clock from the
serial line. The frequency of this clock
must match the frequency you select in
the IP parameter editor. It should also
match the frequency of the tx_pll_ref_clk
reference clock for the TX PLL at the
Source variant.

ngnt _reset _n Input 1 Design example asynchronous master
reset. Assert this reset signal to reset the
overall design example system.

This is an active low signal.

snk_core_reset_n Output 1 Demo management module asserts this
signal to reset traffic checker module.

src_core_reset_n Output 1 Demo management module asserts this
signal to reset traffic generator module.

Data Signal
rx[ n] Input Based on Number | This vector carries the transmitted
of Lanes value streaming data from the core.
N represents the number of lanes.
tx[ n] Output Based on Number | This vector carries the transmitted

of Lanes value streaming data to the core.
N represents the number of lanes.

Status Signal

rx_activity_n Output 1 This single bit signal indicates that the
data is valid.

tx_activity_n Output 1 This single bit signal indicates that the
data is valid.

snk_link_up_n Output 1 The core asserts this signal to indicate

that the core initialization is complete
and is ready to receive user data.

src_link_up_n Output 1 The core asserts this signal to indicate
that the core initialization is complete
and is ready to transmit user data.
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3. Detailed Description for Intel Arria 10 Serial Lite III
Streaming Advanced Clocking Mode

These design examples demonstrate the functionalities of data streaming using
advanced clocking mode.

To generate the design examples, select the following preset(s):
e Advanced Clocking Mode 2x10G
e Advanced Clocking Mode 6x12.5G

By default, the design examples are generated as duplex core. To generate the design
examples in simplex core, select Simplex for the Direction parameter.

3.1. Features

Features for Advanced Clocking Mode 2x10G design example includes:
e Support 2 lanes with 10Gpbs transceiver data rate

e Support simplex and duplex transmission modes

e Traffic checker for data verification and lane de-skew verification

e Support CRC error injection using Nios II processor

Features for Advanced Clocking Mode 6x12.5G design example includes:
e Support 6 lanes with 12.5Gpbs transceiver data rate

e Support simplex and duplex transmission modes

o Traffic checker for data verification and lane de-skew verification

e Support CRC error injection using Nios II processor

3.2. Hardware and Software Requirements
Intel uses the following hardware and software to test the example designs in a Linux
system:
e Intel Quartus Prime software

e ModelSim - Intel FPGA Edition, Modelsim-SE, NC-Sim (Verilog only), or VCS
simulator

e Intel Arria 10 GX Transceiver Signal Integrity Development Kit for hardware
testing

3.3. Functional Description

The design examples consist of various components. The following block diagrams
show the design components and the top-level connections of the design examples.

Intel Corporation. All rights reserved. Agilex, Altera, Arria, Cyclone, Enpirion, Intel, the Intel logo, MAX, Nios,
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information and before placing orders for products or services.

*QOther names and brands may be claimed as the property of others.


mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20Serial%20Lite%20III%20Streaming%20Intel%20Arria%2010%20FPGA%20IP%20Design%20Example%20User%20Guide%20(UG-20030%202019.05.13)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html
https://www.intel.com/content/www/us/en/quality/intel-iso-registrations.html

3. Detailed Description for Intel Arria 10 Serial Lite III Streaming Advanced Clocking Mode

UG-20030 | 2019.05.13

Figure 16.
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Figure 17.
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Design Example for Duplex Core in Advanced Clocking Mode
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The design example consists of following components:

Serial Lite III Streaming IP core variation

ATX PLL

Source user clock—I/O PLL

Traffic generator
Traffic checker

Demo control

Demo management

Nios II processor code

3.3.1.1. Serial Lite III Streaming IP Core

The Serial Lite III Streaming IP core variation accepts data from the traffic generator
and formats the data for transmission. It also receives data from the link, strips the
headers, and presents it to the traffic checker for analysis. The core is generated using
the parameter editor in the Intel Quartus Prime software.
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3.3.1.2. Source User Clock -I/0 PLL

The I/0 PLL generates a user clock for sourcing data into the Serial Lite III Streaming
IP core when configured in Advanced Clocking Mode.

3.3.1.3. ATX PLL

The ATX PLL generates transmit transceiver clock to the Serial Lite III Streaming IP

core.

Related Information

How to compensate the jitter of PLL cascading or non-dedicated clock path for Intel
Arria 10 reference clock?
In previous Quartus Prime versions, reference clock from a cascaded PLL output,
global clock, or core clock causes additional jitter in Intel Arria 10 Serial Lite III
Streaming IP core design example. If you are migrating your design from earlier
versions to Quartus Prime 17.1, refer to the KDB link.

3.3.1.4. Traffic Generator

The traffic generator generates traffic in a deterministic format to verify that data is
transmitted correctly across the link. Traffic consists of sets of sample words, one for
each lane on the link, that are presented to the source user interface.

Figure 18. Traffic Generator Sample Word Format
This figure shows the format of the sample words generated for each lane.
3l SIS 3l 71815 3151315 51013 718 5 4 1512 0 313 313 313 31313 51517 5 5 315 317121312171 a 1al3121115 o[ o[s[[s[2]]o
Byte7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0
7/6/54]s[2]1]o|7[6]s|43]2|1]o|7[s |5 |4 3 2|1 |o|7|6[s]4|3|2 10| 7|6|s|4|3|2]1]o|7| 6|8| 4|3[ 2| 1]0|7]6]s] ]3] 2]1]o|7] 65| 4] 3] 2| 1]0
Word ID Burst Count Word Count
Table 7. Traffic Generator Sample Word Fields
Field Bits Description

Word ID 63-59 Contains a static value to distinguish which 64-bit word on the user interface that this
sample was presented on. The Word ID value ranges from 0 to (lanes - 1).

Burst Count 58-32 Tracks the number of bursts used to transfer the sample data. This field value starts with
one after reset and is incremented each time the st art _of _bur st signal is asserted on
the source user interface.

Word Count 31-0 Tracks the number of valid sample words that have been transferred, across all bursts, to
the source user interface.
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3.3.1.5. Traffic Checker

The traffic checker performs the following inspections to verify that the received data
conforms to the expected format:

e Checks each sample word to verify that the expected word ID was received.

e Checks each sample word to verify that the word count value is higher than the
word count value from the last valid sample word.

e \erifies that lane de-skew has been properly performed by validating that the
word count and burst count values from the sample word are the same as the
values received from the adjacent lane.

e Ifthe start_of _burst signal is asserted on the user interface, verifies that the
burst count value in the current sample word is higher than the burst count value
from the last valid sample word. Otherwise, it verifies that the burst count value
has not changed.

3.3.1.6. Demo Control

The demo control module is a Nios II processor system, generated in Platform
Designer (Standard), to control the demo hardware.

Demo control module also consists of a timer to track interrupt occurrence, Avalon-MM
interface to access demo management and the Serial Lite III Streaming Intel FPGA IP
PHY interface, a reset controller, a UART interface, and an Avalon Streaming (Avalon-
ST) interface.

3.3.1.7. Demo Management

The demo management module controls the user modules interaction with the Serial
Lite III Streaming IP core such as enable and disable traffic generator and traffic
checker, enable CRC error insertion, and provide user clock reset for Serial Lite III
Streaming IP core. The module also implements CSRs to control and monitor the
design operation. This includes CSRs to monitor and log errors that occur during the
operation.

3.3.1.8. Nios II Processor Code

The Nios II processor controls the options exercised in the design example. The code
also enables the configuration RAM (CRAM) bits for CRC-32 error injection support.

The design example sets the bit for channel 0 that connects to lane 0 in the design
example. Therefore, CRC error injection is exercisable for lane 0 only. Refer to the
Nios II processor source code (denmp_control . ¢) for information on setting bits for
other channels.

The deno_cont rol . ¢ program Intel Stratix® 10 H-tile and L-tile devices uses the
control registers to dynamically toggle the r x_seri al | pbken port on the Transceiver
PHY block to change the TX to RX loopback from internal to external.
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3.3.2. Reset Scheme

The ngnt _r eset _n reset signal controls the overall reset structure for the design
example. This is an asynchronous and active-low signal. Asserting this signal resets

the demo control module and the Serial Lite III Streaming IP core. The traffic

generator and traffic checker modules get reset through the demo management and
the Serial Lite III Streaming IP core.

The following diagrams show the reset scheme implemented in the design examples.

Figure 19. Reset Scheme for Intel Arria 10 Serial Lite III Streaming Simplex Core in
Advanced Clocking Mode
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Figure 20. Reset Scheme for Intel Arria 10 Serial Lite III Streaming Duplex Core in
Advanced Clocking Mode
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3.3.3. Clocking Scheme

The following diagrams show the clocking scheme for the design examples.
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Figure 21. Clocking Scheme for Intel Arria 10 Serial Lite III Streaming Simplex Core in
Advanced Clocking Mode
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Figure 22. Clocking Scheme for Intel Arria 10 Serial Lite III Streaming Duplex Core in
Advanced Clocking Mode
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3.4. Simulation

The simulation test cases demonstrate continuous streaming of 2000 sample data for
all lanes from traffic generator to the Serial Lite III Streaming source core and
externally loopback to the sink core in advanced clocking mode.

The simulation test case performs the following steps:
1.

gu A W N

Initialize and configures Serial Lite III Streaming IP core, traffic generator and

traffic checker.

Traffic generator generates data and starts data transmission.

Logs and display link up status and burst information.

Traffic checker verifies received data and stop transmission.

Testbench logs and displays test result and test information.
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3.4.1. Testbench

If your design targets Intel Arria 10 devices, the generated example testbench is
dynamic and has the same configuration as the IP.

Note: The Intel Arria 10 example testbench includes the external transceiver PLL; the IP
core does not include the transceiver PLL for these devices.

Figure 23. Serial Lite III Streaming Example Testbench (Duplex) for Intel Arria 10
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Figure 24. Serial Lite III Streaming Example Testbench (Simplex) for Intel Arria 10
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3.5. Hardware Testing

Once you download the design and accompanying software into the FPGA, you can
test the design operation through the interactive session. The interactive session
provides helpful statistics, as well as controls for controlling various aspects of the
design.

You can control the following operations through the interactive session by entering
the option numbers listed below:

1. Enable Data Generator/Checker—Enables the traffic generator and start
sending out data. This option enable data streaming in continuous mode.

Disable Data Generator/Checker—Disables traffic generation.
Reset Source Core—Resets the source core and traffic generator.
Reset Sink Core—Resets the sink core and traffic checker.

Display Error Details—Displays the error statistics.

o vk wN

Toggle Burst/Continuous Mode—Resets the source and sink MACs and
switches the traffic generator to generate a burst or continuous traffic stream. By
default, the design example is set to burst mode. When in continuous mode, the
burst count will always show 1. Disable the data generator/checker before
switching mode to avoid transmission error.

7. Toggle CRC Error Insertion—Turns CRC error injection off or on. By default, the
design example has CRC error injection turned off.

3.5.1. Design Setup

The design example targets the Intel Arria 10 Transceiver Signal Integrity
Development Kit.

The design includes an SDC script as well as a QSF with verified constraints in
loopback mode. If you use the design example with another device or development
board, you may need to update the device setting and constraints in the QSF file.

You must use correct pin constraints when using the core in simplex mode or when
using more than one reconfiguration controller. The synthesized design typically
includes a reconfiguration interface for at least three channels because three channels
share an Avalon-MM slave interface, which connects to the Transceiver Reconfiguration
Controller IP core. Conversely, you cannot connect three channels that share an
Avalon-MM interface to different Transceiver Reconfiguration Controller IP cores or you
will receive a Fitter error.

Related Information

Altera Transceiver PHY IP Core User Guide
More information about the Interlaken PHY IP core.

3.5.2. Error Details

These are the list of supported errors in the design example.

Serial Lite ITI Streaming Intel Arria 10 FPGA IP Design Example User Guide D Send Feedback

32


http://www.altera.com/literature/ug/xcvr_user_guide.pdf
mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20Serial%20Lite%20III%20Streaming%20Intel%20Arria%2010%20FPGA%20IP%20Design%20Example%20User%20Guide%20(UG-20030%202019.05.13)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

m ®
3. Detailed Description for Intel Arria 10 Serial Lite III Streaming Advanced Clocking Mode l n tel
UG-20030 | 2019.05.13

Table 8. List of Error Details
Error | Description

Source Error:
Adaptation FIFO Overflow | To indicate source adaptation FIFO overflow error.
Sink Errors:
Adaptation FIFO Overflow To indicate sink adaptation FIFO overflow error.
Loss of Alignment During Normal Operation To indicate loss of alignment error (error _rx[ 1] ).
Meta Frame CRC Errors To indicate CRC errors.
Lane Swap Errors To indicate lane swap errors in traffic checker.
Lane Sequence Errors To indicate lane sequence error in traffic checker.
Lane Alignment Errors To indicate lane alignment error in traffic checker.

3.6. Signals

Figure 25. Top-level Signals for Intel Arria 10 Serial Lite III Streaming Advanced
Clocking Mode Design Example
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Signal

Direction Width

Description

Clock and Reset Signal

mgnt _cl k

Input

Input clock for:

e Avalon-MM PHY management
interface for Serial Lite III Streaming
IP core

e Demo management module
e Demo control module
e Transceiver reset controller

pll_ref_clk

Input

This reference clock is used by the Clock
Data Recovery (CDR) unit in the
transceiver. It serves as a reference for
the CDR to recover the clock from the
serial line. The frequency of this clock
must match the frequency you select in
the IP parameter editor. It should also
match the frequency of the tx_pll_ref_clk
reference clock for the TX PLL at the
Source variant.

mgnt _reset _n

Input

Design example asynchronous master
reset. Assert this reset signal to reset the
overall design example system.

This is an active low signal.

snk_core_reset_n

Output

Demo management module asserts this
signal to reset traffic checker module.

src_core_reset_n

Output

Demo management module asserts this
signal to reset traffic generator module.

Data Signal

rx[ n]

Input

Based on Number
of Lanes value

This vector carries the transmitted
streaming data from the core.

N represents the number of lanes.

tx[ n]

Output

Based on Number
of Lanes value

This vector carries the transmitted
streaming data to the core.

N represents the number of lanes.

Status Signal

rx_activity_n

Output

This single bit signal indicates that the
data is valid.

tx_activity_n

Output

This single bit signal indicates that the
data is valid.

snk_l i nk_up_n

Output

The core asserts this signal to indicate
that the core initialization is complete
and is ready to receive user data.

src_link_up_n

Output

The core asserts this signal to indicate
that the core initialization is complete
and is ready to transmit user data.
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